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Information in this document refers to features available in Version 12 

of Pearl Softwareôs Echo.Suite  software .  If you have purchased a 

module of Pearl Echo.Suite  such a s Website.E cho or IM. Echo, please 

refer to http://www.pearlsw.com/products/comparison.html  for a list 

of features available with  your product  and described herein . 

Information in this document, including URL and other Internet web 

site references, is subject to chang e without notice.  Complying with 

all applicable copyright laws is the responsibility of the user.  Without 

limiting the rights under copyright, no part of this document may be 

reproduced or transmitted in any form without the express written 
consent of Pe arl Software, Inc.  

Pearl Software may have patents, patent applications, trademarks, 

copyrights, or other intellectual property rights covering subject matter 

in this document.  Except as expressly provided in any written license 

agreement from Pearl Softw are, the furnishing of this document does 

not give you any license to these patents, trademarks, copyrights, or 
other intellectual property.  

©20 15 Pearl Software, Inc.  All rights reserved.  

TRADEMARKS: Pearl Software, Pearl Echo, Echo.Suite , Echo.F ilters ,  

Website.Echo , I M.Echo , and Mobility Monitor  are either registered 
trademarks or trademarks of Pearl Software, Inc.  

The names of actual companies and products mentioned herein may 
be the trademarks of their respective owne rs.  

PATENTS:  Pearl Echo.Suite , Website.Echo  and I M.Echo are protected 

by one or more patents including U.S. Patent Nos. 6,978,304; 

7,634,571; 7,958,237 ; 8,930,535 . For more information about our  

patents,  please visit: Patent  ï 

http://www.pearlsoftware.com /about/ patents .html
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Getting Started  

Welcome  

Introducing Pearl Echo Ñ, a comprehensive employee Internet management 

package fro m Pearl Software. This premier tracking utility is the industry 

model for employee Internet access monitoring , filtering and control  and  

represents the most significant step available today in promoting responsible 

Internet use in the workplace  and at scho ol . Featuring Pearl Software's 

Mobility Monitor Ê technology, Pearl Echo  can effectively block inappropriate 

sites or set time restrictions on Internet use, regardless of where end -users 

reside. Pearl Echo  provides real - ti me control and capture of communicated 

content through IM and e -mail and provide s detailed access configurations  for 

your organization . Pearl Echo 's Quick -Link  feature allows complete restoration 

of  all text from outbound and inbound com munications. Pearl Echo  is a 

powerful application, offering dynamic filtering, reporting and knowledge 

management functions to assist you in fulfilling your regulatory compliance 
and governance requirements.  

About th is Userôs Guide  

The Pearl Echo  Userôs Guide describes Pearl Echo ôs features and functions as 

well as installation instructions and deployment strategies.  It is assumed that 

the reader  has a general understanding of  TCP/IP  networking concepts as well 

as Microsoft Windows® operating systems.  Th is guide is supplemental to 

Pearl Echo ôs context sensitive help found in the Pearl Echo  Administration 
Console under the programôs Help menu. 

Pearl Echo  Architecture  

Pearl Echo ôs Employee Internet Management technology is based on an 

independent agent -serv er architecture.  By creating an independent service, 

Pearl Echo  is not affected by high traffic volumes, how users access the 

Internet, or where your end users are physically located.  Pearl Echo ôs 

Employee Internet Management technology does not suffer f rom the 

performance and security problems of proxy monitoring solutions or from the 

overload and network dependency limitations of network sniffer solutions.  

Chapter  

1 
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The Pearl Echo  Server Software runs as an independent service resident on 

one of your Windows Dom ain or Stand Alone Servers or on a Windows 

Workstation.  The Internet access rules you create at the Pearl Echo  

Administration Machine  are retrieved by your managed workstations through 
a secure, zero -maintenance agent loaded on your Windows workstations.   

 

The same secure, zero -maintenance agent is responsible for sending --  or 

echoing --  actual or attempted Internet transactions back to the Pearl Echo  

Administration Machine .  For ultimate efficiency, Internet access rules are 

applied at the workstation by the Pearl Echo agent . Data to be logged is first 

compressed by the agent in order to minimize network overhead . The Pearl 

Echo  Workstation agent is deployed automatically from the Pearl Echo 

Administration Console or can be installed  with a third party software 

management tool .  Once deployed, the Pearl Echo  Workstation agent is self -

updating ; the Workstation agent automatically retrieves  any updates or 
upgrades to Pearl Echo  when you update your Pearl Echo  Server Software . 

With Pearl Echo 's Mobility Mon itor Ê technology, managed workstations can 

be connected to your local area network, wide area network or completely 

detached from your private network.  The Pearl Echo  Workstation agent 
functions  no matter how or where yo ur users connect to the Internet.  

Pearl Echo is not a Proxy Server .  Users can have access to the Internet 

through any means -  a direct connection, proxy connection, shared 

connection, etc.  The Pearl Echo Administration Machine runs independently 

and is t he point at which you define Internet access privileges as well as 

perform user Internet access analysis and reporting.  Because Pearl Echo  runs 

as its own service, Echo has no dependences on legacy Proxy Servers or 
Firewalls.  
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Installing Pearl Echo  

Step 1 : Echo Server  Software  Installation  

The Pearl Echo  Server Software can be installed on any supported Microsoft 

Windows platform whose IP address can be directly or indirectly (NAT) 

accessed by your managed workstations.  The Pearl Echo  Server Software is 

typically installed on a shared or dedicated Windows Server platform but can 

even be installed on a Windows Workstation platform.  If you use Active 

Directory and w ould like to set Internet access privileges based on  existing 

Active Directory User, Group  or Computer  names, you should install Pearl 

Echo  Server Software on a machine that is a member of your Domain.  The 

machine can be a Windows Domain Controller but need not be as the Pearl 

Echo  service is Domain -Aware and will automatically find your dat abas e of 

Active Directory Users, Groups  and Computers 1.   If you donôt use Active 

Directory, Pearl Echo  will automatically revert to the machineôs local list of 

Users and Groups.  Pearl Echo  will even accommodate smaller peer - to -peer 

installations and allow yo u to set Internet access profiles based on local login 

names  and computers .  Regardless of your environment, there are no 

complicated setup steps for you to worry about.  The Pearl Echo  Server 

Software will automatically sense its environment and will conf igure itself 
accordingly.  

Follow these steps to install the Echo Administration Console and Monitoring 

Service:  

1.  Disable Antivirus & Antispyware applications prior to installation.  

2.  Run the secure setup.exe from the program installation folder or from 

the installation CD.   

3.  On the Startup screen, select the Server Setup Button.  

4.  The InstallShield Wizard will walk you through the initial installation 
procedures and prompt you to confirm the default installation settings.  

 

5.  Configur e your antivirus and antispyware applications to exclude from 

scanning the Pearl Echo program file directory that you created in 

number 4 (typically C: \ Program Files (x86) \ Pearl Echo).  

6.  Launch the Pearl Echo Administration Console from the Programs 

section  of the Windows Start button.   

 
1 The Active Directory container(s) of your Users and Group members, resident on your domain 
computer(s), are ma pped by the Echo Server.  It is recommended that the computer running the 
Pearl Echo  Server be explicitly added to the list of security objects for your User and Groups 
containers and the computer be given read permissions on those containers.  

TIP  
Note the destination locati on for your installation as you will need to exempt this 
folder from your antivirus & antispyware applications.  
 

R You can 

automate 
workstation 
installation from 
the Pearl Echo 
Administration 
Console.  
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7.  Enter your Company 

name and purchased 

serial number.  For 

demo installations  

a.  Select the 

Demo button 

to generate a 

trial activation 

code.  Note: 

Stealth Mode 

is disabled in 

Demo mode.  

b.  Enter  the  trial 

activation code 

into the first  

ñSerial 

Number :ò field and select Next.  

 

8.  Confirm or Enter your IP settings:   

a.  When prompted, confirm or enter the fixed  IP address of the 

Pearl Echo Administration Machine  ( the server IP cannot be 

assigned via 

DHCP).  

b.  We recommend 

that you use 

the de fault Port 

number 58000.  

c.  Enter the Public 

IP or FQDN of 

the Pearl Echo 

Administration 

Machine  if any 

of the managed 

end -user 

machines will 

roam outside of 

your local 

network.  To 

manage users 

while they roam outside of your local network, you will need to  

configure your firewall to allow the roaming Pearl Echo 

Workstation agent to make a connection back to the Pearl Echo 

Administration Machine . Please refer to the Advanced 

Installation chapter  of this Userôs Guide for additional 

information on managing you r remote users.   

9.  Enter a password to use when connecting to the Pearl Echo 

Administration Console.  This password will also be used to securely 

uninstall the Pearl Echo Workstation Software, if needed.    

10.  Confirm that you wish to turn Pearl Echo Internet Ma nagement on 

Now.  This setting  starts the Echo Monitoring Services  and must be 
ON to begin the Pearl Echo Workstation Installation.  
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Step 2: Automat ed  Pearl Echo  Workstation Installation  

(Skip to the next Step if you choose to manually install the Echo Wor kstation 
Software  or if you do not user Active Directory )  

You can manage Echo Workstation installation and removal from your Echo 

Administration Console.  After completing the Workstation Software 

installation, there will be no indication to a user that th e Echo Workstation 
Software components are resident and running  (licensed versions only) . 

1.  Create or open a network share and copy the Workstation folder from 

the Pearl Echo CD. The network share must be accessible to both the 

Echo Administration Machine as  well as the target workstation.  

2.  Verify that the network share has read and write share  permissions for 

your account on the Echo Admi nistration Machine (preferably Domain 

Admin).  

3.  You must have login credentials permitting you to perform a software 

installa tion on the targe t workstation (preferably Domain A dmin). 

Verify that the network share has read and write share  permissions for 
this account as well (if different from the previous step).  

 

4.  Select the target 

workstation on whic h 

to install the Echo 

Workstation Software.  

 

The target workstation 

must have file and 

print sharing enabled.   

 

(You will be able to 

select multiple 

workstation targets for 

simultaneous 

deployment when you 

enter the 

Administration 
Console.)  

 

TIP  
Check File and Print sharing settings in the workstationôs Control Panel | Network 
and Internet | Network and Sharing Center | Advanced Sharing settings. For help 
on easy methods to enable file and print sharing on your network, visit 
pearlsoftware.com/help/install.  

 

TIP  
Access to a folder on a file server can be determined through two sets of permission 
entries: the share permissions set on a folder and th e NTFS permissions set on the 
folder.  For the access permissions above, make sure you are working with share  
permissions.  
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5.  Specify the UNC path 

to the Workstation 

installation files you 

copied to the network 

share in 1, above.  The 

wizard will verify that 

the necessary share 

permissions exist for 

this directory. You 

must specify a UNC 

path as this path will 

also be referenced  by 

the target workstation 

to access the Echo 

Workstation 

installation files.   

6.  The Echo Workstation installation requires a system reboot.  Specify 

when the target workstation should restart.  Note that forcing an 

immediate workstation rest art from the Administration Console will 

reboot the target workstation without warning potentially active end -

users.  

7.  Enter the login 

credentials permitted 

to perform a software 

installation on the 

target workstation.  

8.  Click óNext>ô. Once 

complete, a log fi le will 

be generated 

displaying installation 

results including any 

errors if they occurred.  

9.  Now that you have 

installed the Echo 

Workstation Software, 

begin browsing the 

Internet from the 

workstation in order to 

test your initial setup.   

10.  Return to the Ech o Administration Console to view the monitored 

activity.  You should see the workstationôs Internet activity presented 
after opening or refreshing the Pearl Echo Activity Log.   

Step 2 (Optional): Manual Pearl Echo Workstation Installation  

The Echo Server S oftware must be installed with Internet Management 

set to ON  prior to installing the Echo Workstation Software.  To complete this 

installation, you will need the Echo Administration Machine IP address or 

FQDN, port and, if appropriate, the public Echo Admi nistration Mach ine IP or 

FQDN entered in Step 1  point 8 above.  After completing the Workstation 

Software installation, there will be no indication to a user that the Echo 

Workstation Software comp onents are resident and running  (licensed versions 
only) .  
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Follow these steps to manually install the Echo Workstation Agent:  

1.  Login to the workstation using an account with Administrator privileges.  

2.  Disable  antivirus and anti spyware applications before beginning 

installation.   

3.  Run the secure setup.exe from the program installation folder or from the 

installation CD.   

4.  Select  Workstation Setup  from the startup screen.  

5.  Enter the E cho Administration Machine  FQDN or IP address entered in 

Step 1 part 8a of the Echo Server Software Installation above.   (Note: 

FQDN is recommended in case you later move or upgrade your 

Administration Machine  to a new IP.)    

6.  Enter the Port number that you specified during the Echo Server Software 

Installation in Step  1 part  8b above  (58000 by default) . 

7.  If the workstation will roam outsid e of your private network, enter the 

Public IP or FQDN of your Echo Administration Machine entered in Step 1 

part  8c, above.   To manage users while they roam outside of your private 

network, you will need to configure your firewall to allow the roaming 

Echo Workstation Software to make a connection back to the Pearl Echo 

Administration Machine on four ports (58000 -58003 by default). Please 

refer to Advanced Installation instructions  in Chapter 2 of this Userôs 

Guide .   

8.  Select a Tamper Security level . The Medium  setting  is recommended 
during evaluation.  
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9.  The workstation will perform a test communication with the Pearl Echo  

Service and will display the results.  If a link can be established, reboot 
your Echo workstation to complete  the installation.  

 

10.  Configure your antivirus and anti spyware applications to exclude the 

Pearl Echo  Workstation program file directory folder.  You will also 

need to configure anti -virus and anti spyware applications to not distur b 

the Pearl Echo  Workstation Agent or its components.  R efer to this Guideôs 

Appendix for detailed guidelines.  

11.  Now that you have installed the Pearl Echo Workstation agent, begin 

browsing the Internet from this workstation or, if applicable, send IM 

and/or  email messages from this workstation to test your initial setup.   

12.  Return to your Administration Machine and launch the Pearl Echo  

Administration Console to view the monitored activity.  You should see the 
workstationôs Internet activity presented in the Pearl Echo  Activity Log.  

TIP  
During your initial installation, if your workstation does not communicate with your 
Pearl Echo M onitoring Services, here are some common issues that may need to be 
addressed:  
 

¶ Firewall. Firewall. Firewall.   If a software firewall is on the Pearl Echo 
Administration Machine, add the rule to allow the Pearl Echo process 
echoComm.exe. If a software fire wall is on the managed Workstation, add 
the rule to allow the Pearl Echo processes rnappp7.exe and updater7.exe. 
(The installation software attempts to configure these settings 
automatically.) If a hardware firewall is installed between your Pearl Echo 
Adm inistration Machine and managed Workstations, please be sure to 
make the firewall port assignments as detailed in Chapter 2 of this Userôs 
Guide.   

¶ Make sure you have correctly identified and set your Administration 
Machine's FIXED IP address in the Pearl Echo Administration Console under 
the Options ->Network Configuration menu.  

¶ Make sure your Pearl Echo management is ON in the Pearl Echo 
Administration Console under the Security ->Set Security Status menu.  

 

TIP  
You can configure your managed workstations to provide a Low, Medium or High 
level of tamper security and prevention. Set to Low, Pearl Echo will not prevent 
users from accessing the Internet if Pearl Echo components have been altered 
manually or by third party applications such as antispyware or antivirus software.  
This is useful in environments  where security tools cannot be configured to exempt 
Pearl Echo or on workstations that have become unstable due to viruses, 
unauthorized applications or neglect.  With Tamper Security set to Medium, Pearl 
Echo will prevent access to the Internet if Pearl Echo components have been 
altered.  This is the default setting and is targeted to well -managed environments.  
When Tamper Security is set to High, Pearl Echo will prevent access to the Internet 
if Pearl Echo components have been altered or if access to th e Pearl Echo Services 
is not available on your server.  The Echo Service may be unavailable due to server 
maintenance, network problems, trial expiration, etc.   
 
Please note, if you are running an evaluation version of Pearl Echo, the Echo service 
will no t be available once your trial period has expired.  After expiration, a 
workstation with Tamper Security set to High will have Internet access blocked.   
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13.  Congratulations!   You have successfully completed the initial installation.  

For detailed information on procedures and tips to help you continue a 

successful implementation using more advanced deployme nt options , 
please refer to the Advanced Installation  chapter of  this Userôs Guide. 

TIP  
If you do no t see the workstation activity, y ou might need to refresh your Pearl 
Echo activity log from the File menu or by selecting the F5 key while in the Pearl 
Echo Administration Console . 
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Upgrading from a Previous Version of Pearl Echo  

The instructions contained in this section  are for major  release upgrading  only 

(e.g. 10 .0 9.000 9 to 12 .0 3.000 3). For minor release patching  (e.g. 

12 .0 1 .000 1  to 12 .0 3 .000 3 ) , follow the patching  instructions at 

www.pearlsoftware.com/echo 12 /updates . Pearl Echo Version 12  will 

automatically gather your existing settings from Pearl Echo Version 5 or later.  

You must have a valid Ve rsion 12  serial number to successfully upgrade from 
a previous version.  

Server Software Upgrade  

Before installing and activating the Version 12  Server Software,  

1.  Login to the Administration Console of your previous version of Pearl Echo 

and turn Internet Ma nagement OFF from the Set Security Status menu.  

2.  Make note of your network settings in the Options ->Network Settings 

menu.   

3.  Close the Pearl Echo Administration Console.  

4.  Make a backup copy of your Pearl Echo Server installation directory.  

Server Software Up grade  from Version 8 and Later  

Upgrading from Version 8  through Version 11  should be accomplished using 

the Pearl Echo 12  server installation software. A link to the full product 

download is emailed during trial registration and order confirmation.  When 

run against your previous server software install, all settings and data will be 

maintained.   

1.  Run setup.exe from the downloaded Version 12  installation CD.  

2.  On the Startup screen, select the Server Setup Button.  

3.  The InstallShield Wizard will prompt you to c onfirm the default installation 

settings.  

4.  Once complete, login to the Administration Console and enter your Version 

12  serial number in the Help ->About Pearl Software menu.  
5.  Select ñOKò and re-enable Internet Management when prompted.  

Server Software Upgrad e from Version 7 or Earlier  

Install and run the full version of Pearl Echo Version 12  in a new program 

directory. A link to the full product download is emailed during trial 

registration and order confirmation. When prompted, use the same IP and 

Port sett ings as your previous installation.  Your pervious versionôs profiles, 

lists, active data and report settings will automatically be migrated to your 

new installation.  After you confirm migration of your previous versionôs 

settings, uninstall the previous version Pearl Echo Server Software from 
Add/Remove Programs.  
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Workstation Software Upgrade  

It is recommended that you upgrade your Pearl Echo Workstation Software in 

order to take advantage of the added features and new filtering module 
changes ava ilable in this latest version.    

Workstation  Software Upgrade  from Version 7 and Later  

Previous versions of Pearl Echo Workstation must be patched to Version 

10.099  or later  to automatically  upgrade your Pearl Echo Workstation agents 
to Version 12 .  

Part 1:  

1.  If P earl Echo Workstation agents are not at version 10.099  or later , 

download the Version 10.099 Workstation patch from the Pearl Software 

website, www.pearlsoftware.com/echo10/updates.  

2.  Place the Version 10.099 Workstation patch in the WS_Updates folder 

found  in the directory where you installed the Pearl Echo Version 12  
Server Software.   

The Pearl Echo Administration Machine will automatically deliver the patch  to 

Pearl Echoôs workstation agent. After delivery, the self-updating agent will 

patch  itself the n ext time the machine on which the workstation agent resides 
is restarted.  

Part 2:  

1.  To complete the Version 12  upgrade , place the Pearl Echo 12  Workstation 

upgrade file, Upgrade_ 12 0xx_WS.msi, in the WS_Updates folder found in 

the directory where you installe d the Pearl Echo Version 12  Server 

Software.  The upgrade file is found in the Workstation directory on the 

downloaded installation CD. Previous patches and this upgrade file can co -
exist in the WS_Updates folder.  

The Pearl Echo Administration Machine will  automatically deliver the upgrade  

to Pearl Echoôs workstation agent. After delivery, the self-updating agent will 

upgrade  itself the next time the machine on which the workstation agent 
resides is restarted.  

Version 6 or Earlier Workstation Upgrade  

If you  are upgrading your Version 6 or earlier workstations to Version 12 , you 

will need to uninstall your previous version of the Pearl Echo Workstation 

Software before installing Pearl Echo 12  Workstation components.  This can 

be accomplished by removing the s oftware from the Workstationôs 

Add/Remove Programs applet .  Because the Pearl Echo  Workstation 

Software  is a secure installation, it cannot be removed with a Group 

Policy Object.  
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Uninstalling Pearl Echo 

Pearl Echo provides a secure uninstaller for the Pe arl Echo Workstation Agent.  

To reduce visibility, a Pearl Echo entry does not exist in the Workstationôs Add 

Remove Programs window.  The Pearl Echo  Service is required to authenticate 

Pearl Echo  Workstation uninstall requests. For this reason, t he Pearl Echo 

Service must be running to securely uninstall workstation components.   To 

run the Pearl Echo  Service, set the Internet Management State to ñONò in the 
Pearl Echo  Administration Console.  

To Uninstall Pearl Echo  Workstation Software  

Option 1: Automated  Pearl Echo Workstation Software Uninstall  

1.  Run the Pearl Echo Administration Console.  

2.  From the Security Menu, select Manage Workstation Software.  

3.  Select the Remove tab.  

4.  Select the machine(s) targeted for software removal.  

5.  Enter your Pearl Echo password, doma in credentials and follow the 

instructions as they appear on the screen.  

Option2: Manual  Pearl Echo Workstation Software Uninstall  

1.  From the workstation tas kbar, click on Start and select Run.  

2.  Enter ec7unins.exe and select OK.  

3.  Enter your Pearl Echo passwor d and follow the instructions as they appear 
on the screen.  

Pearl Echo  will log successful and unsuccessful attempts at uninstalling the 

Pearl Echo  Workstation Software .  Pearl Echo  will also log when the 
Workstationôs network configuration has been altered.  

Important Note:  Because the Pearl Echo Workstation Software is a secure 

installation, it cannot be removed with Group Policy Object.  Removing the 

software can only be accomplished from the Workstation as above or 

automated from the Echo Administration  Console.   

To Uninstall Pearl Echo  Server Software  

1.  Run the Pearl Echo  Administration Console . 

2.  From the Security Menu, select Set Security Status.  

3.  Turn the Pearl Echo  Management State  ñOFFò and exit Pearl Echo . 

4.  Select the Windows Control Panel.  

5.  Select  Add/ Remove Programs.  

6.  From the Install/Uninstall tab, click on Pearl Echo . 
7.  Select  the Add/Remove button.  
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Advanced Installation  

Network Address Translation  

Pearl Echo  can be configured to work with Network Address Translation 

(NAT). Use this configurat ion if the NAT device provides IP and PORT 

translation between the internal Pearl Echo  Administration Machine  and 
external or roaming Pearl Echo  Workstations.  

 

1.  Start the Pearl Echo  Administration Console.  

2.  From the Security Menu select Set Security Status.  

3.  Turn Pearl Echo  Internet Management OFF.  

4.  From the Options Menu select Network Settings.   

5.  Enter the External IP address or Fully Qualified Domain Name (FQDN) of 

the NAT device in the ñServer Public IP or FQDNò box. 

6.  From the Security Menu select Set Securi ty Status.  
7.  Turn Pearl Echo  Internet Management ON.  

NOTE: A Fully Qualified Domain Name provides greater flexibility if your 

Administration Machine  IP address changes due to server upgrade or network 
architecture changes.  

 

 

 

Chapter  

2 



P E A R L  E C H O  U S E R ô S  G UI D E  

19  

 

 

Firewall Settings  

Pearl Echo ôs Mobility MonitorÊ connects through  a Firewall device utilizing  a 

specified group of ports. Pearl Echo  workstations establish an initial 

connection with the Pearl Echo  Administration Machine  on a Control Port 

(Server Port Number). Additional command and co ntrol communications occur 

on three supplemental IP ports.  The Server Port Number (e.g. 58000) and 

three additional IP ports (e.g. 58001, 58002 and 58003) will need to be 
opened for direct pass - thru on your Firewall device.  

Public IP: Server Port Number +  0  ª Private IP: Server Port Number + 0  

Public IP: Server Port Number + 1  ª Private IP: Server Port Number + 1  

Public IP: Server Port Number + 2   ª Private IP: Server Port Number + 2  

Public IP: Server Port Number + 3  ª Private IP: Server Port Number + 3  

Ex ample:  

 

The Pearl Echo  Monitoring Service residing on the Echo Administration 

Machine  communicates with the Pearl Echo  Workstation Agent through a 

proprietary encoded protocol.  Connections to the Pearl Echo  Monitoring 

Service that donôt communicate with the Pearl Echo  protocol are dismissed.   
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The Pearl Echo  Server Port Number setting is accessed from Network Settings 
in the Pearl Echo  Administration Console ôs Options Menu. 

Terminal/Citrix Server Setup  

Pearl Echo  is fully functional in a Terminal/Citrix S erver environment.  To 

operate in a Terminal/Citrix Server environment, install the Pearl Echo Server 

Software as described in Pearl Echo Server Software Installation, on any 

Windows platform.  The Pearl Echo Server Software can be installed on a 

Domain Co ntroller, a Domain Computer, a standalone machine or on t he 
Terminal/Citrix Sever itself .  

If using Citrix, correct Session Reliability issues as deta iled in Knowledge Base 

Article 9  (www.pearlsw.com/support/kbase .html ). I nstall the Pearl Echo  

Workstation Software  on your Terminal/Citrix server as detailed above in 

Pearl Echo  Workstation Installation .  Once installed, each Terminal/Citrix 

desktop session  will run its own instance of the Pearl Echo  Workstation agent 

and each user  will be fully managed by the  specific settings you create  in the 
Pearl Echo  Administration Console . 

Pearl Echo  will also monitor each user's session, even if the session is run as 

a published  application. For more information on managing published 

applications, please refer to the o nline article, ñUsing Pearl Echo  to Monitor 

Published Applications on Citrix and Windows Terminal Serverò located at 
www.pearlsw.com/support.  

Pearl Echo  has been optimized for a server -centric multi -user environment.  

The Pearl Echo  Agent is extremely eff icient, has a small memory footprint and 

adds negligible network traffic.  To further optimize performance of your 

Terminal/Citrix sessions, it is recommended that you specify the applications 

you would li ke to manage using Pearl Echo .  This is done by sel ecting 

ñApplication Detectionò in the Pearl Echo Administration Consoleôs Options 

menu.  

 

 

 

 

 

 

RAdministrators 

can d efine the 
applications to 
b e managed by 
Echo by selecting 
ñApplication 
Detectionò in the 
Options menu .  
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Workstation Setup  with GPO  

Pearl Echo  supports automatically deploying the  Pearl Echo  Workstation 

installation  from the Pearl Echo Administration Console as desc ribed in 

Chapter 1 of this Userôs Guide. The following describes  the steps necessary to 

install the Pearl Echo Workstation Software  using Microsoftôs Group Policy 
Objects.   

For additional details on using GPO to deploy software applications, including 

tro uble -shooting tips , please refer to Microsoftôs server and online 
documentation.  

Preparation  

Remote Software Installation is performed in conjunction with your settings in 

the configuration file, servset.ini , and the Windows Installer package supplied 

wi th Pearl Echo .   

The first step is creating a network share, called a software distribution point, 

which contains the packages and the program and configuration files. Next 

you need to make sure that Domain Computers can read from the software 

distribution  point and write to the target of the installation. Finally, you need 

to modify the configuration file, servset.ini , with settings that you entered 
during the Pearl Echo  Server Software  installation.  

1.  Create a shared directory that contains all  of the Pearl  Echo  Workstation 

installation files.  Share the directory as echows  

2.  Assign the óReadô NTFS permission for óDomain Computersô on echows 

(Winlogon is the privileged agent that applies software installation policy 

when each computer starts.  Winlogon require s read permissions to the 

source files to complete the installation).  

3.  Edit the file servset.ini in the new directory and specify the Administration 

Machine  IP and Port that you entered during the Pearl Echo  Server 

Software installation.  In addition you wi ll need to specify your Tamper 

Security configuration preference ï low, medium  or high .  If you have 

users that will roam outside of your private network, you can optionally 

enter the public address (FWIP) of your Pearl Echo  Administration 
Machine . 

Example :  

[Echo 12 .0 settings]  

IP=192.168.0.1  

FWIP=echoservername.mycompany.com  

Port=58000  

Configuration= medium  

Setting Group Policy  

Software Installation works in conjunction with Group Policy and Active 

Directory.  Installation is done on computer objects, not user objects.  You 

can install to all computers in your domain or to specified computers in a 

R For additional 

details on using 
GPO to deploy 
software 
applications, 
including trouble -
shooting tips, 
please refer to 
Microsoftôs server 
and online 
documentation.  
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given organizational unit.  In order to ensure that the Pearl Echo  Workstation 

Software  does not get installed on your Domain Controller(s), the Group 

Policy Obje ct that is created should have the appropriate security filters set.  

1.  Open Active Directory Users and Computers from Administrative Tools.  

2.  In the console tree, right -click the domain or organizational unit that 

contains  the computers  for which you want to s et Group Policy.  

3.  Click Properties , and then click the Group Policy  tab.  

4.  Click New  to create a new Group Policy object and rename the object 

echows_gpo .  

5.  Click Properties  of echows_gpo .  

6.  Click Security  

7.  Remove óAuthenticated Usersô from the ACL  

8.  Add óDomain Computersô to the ACL and assign óReadô and óApply 

Group Policyô permissions.  

9.  Verify that óDomain Controllersô is not  part of the ACL.  
10.  Click OK  

To set the Software Installation Group Policy in the echows  Group Policy 
object:  

1.  Click Edit echows_gpo .  

2.  Double -clic k Computer Configuration.  

3.  Double -click Software Settings.  

4.  In the console tree, right -click Software Installation and select New  

Package .  

5.  Enter the UNC name of the Pearl Echo  Workstation installer file(e.g. 

\ \ servername \ echows \ Echo Workstation.msi)  
6.  Select  Assigned.  

If you prefer to mask the software title from appearing during installation on 

Domain Computers, you can edit the properties of the new Software 

Installation entry.  The next time a workstation in the domain starts, it will 

automatically install  the Pearl Echo  Workstation Software  and configure the 

installation to access the Pearl Echo  Administration Machine  specified in 
serv set.ini .  

Important Note:  Because the Pearl Echo Workstation Software is a secure 

installation, it cannot be removed with Gr oup Policy Object.  Removing the 

software can only be accomplished from the Workstation as above or 
automated from the Echo Administration Console.  
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Workstation Setup with 3 rd Party Management Tools  

Pearl Echo supports automatically deploying the Pearl Ech o Workstation 

installation from the Pearl Echo Administration Console as described in 

Chapter 1 of this Userôs Guide. The following describes the steps necessary to 

install the Pearl Echo Workstation Software using third party software 
management tools  tha t utilize the Windows Installer Service .  

You will need to provide your software management tool with the Pearl Echo 

Workstation installation software, Pearl Echo Workstation.msi , as well as the 
installer ñanswer fileò, servset.ini. 

1.  Edit the file servset.i ni to  specify the Administration Machine IP and Port 

that you entered during the Pearl Echo Server Software installation.  In 

addition you will need to specify your Tamper Security configuration 

preference ï low, medium or high.  If you have users that wil l roam 

outside of your private network, you can optionally enter the public 

address (FWIP) of your Pearl Echo Administration Machine.  

 

Example:  

[Echo 12.0 settingsé] 

IP=192.168.0.1  

FWIP=echoservername.mycompany.com  

Port=58000  

Configuration=medium  

Workstat ion Setup using Logon Scripts  

Pearl Echo supports automatically deploying the Pearl Echo Workstation 

installation from the Pearl Echo Administration Console as described in 

Chapter 1 of this Userôs Guide. The following describes automating the Pearl 

Echo  Workstation installation using Windows Logon Scripts. To silently deploy 
the Pearl Echo  Workstation agent:  

1.  Create a shared directory that contains all  of  the Pearl Echo  Workstation 

installation files.  Share the directory as echows  

2.  Create a blank file call ed firsttime.txt in the new directory.  

3.  Edit the file servset.ini in the new directory and specify the Administration 

Machine  IP and Port that you entered during the Pearl Echo  Server 

Software installation.  In addition you will need to specify your Tamper 

Security configuration preference ï low, medium  or high .  If you have 

users that will roam outside of your private network, you can optionally 

enter the public address (FWIP) of your Pearl Echo  Administration 

Machine . 

 

Example:  

[Echo 12 .0 settings é]  

IP=19 2.168.0.1  

FWIP=echoservername.mycompany.com  

Port=58000  

Configuration= medium  
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At login, the workstation will need to run the command  

msiexec.exe /i ñ<path> \ Pearl Echo Workstation.msi ò /q  

where <path> is the  file path to the new directory.  

The following is an example of running a silent install from a userôs login 
script. Installation is run one time for each machine.  

@echo off  

'Checking for first time on target machine  

if exist c: \ firsttime.txt goto vend  

copy \ \ servername \ echows \ firsttime.txt c: \ firsttime. txt  

msiexec .exe  /i " \ \ servername \ echows \ Pearl Echo Workstation.msi" /q  
:vend  

Note 1: The user under which the script is run must have Administrator 

privilege on the machine.  

Note 2: The workstation installation modifies the machineôs network  settings.  

A f orced reboot is included to ensure the stability of the workstation 

(processing running before and after inst allation will have different network  

settings until reboot).  Though it is not recommended, you can suppress the 

forced reboot with the following c ommand:  

msiexec.exe /i ñ<path>\ Pearl Echo W orkstation.msi ò /qn 
REBOOT=ReallySuppress  
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Integration with Microsoft SQL Server  

Pearl Echo  stores monitored Internet activity in its native Microsoft xBase 

database format.  For installations with high volume mo nitoring loads and 

large storage requirements, Pearl Echo  can be  easily  configured to store 

monitored Internet activity to a Microsoft SQL Server (version 2000 or later).  

The Pearl Echo  Server Software can be loaded on the same server that is 

running Micr osoft SQL Server or any other machine that resides in a trusted 

Domain.  Data stored on Microsoft SQL Server can be viewed and reported 

upon from the Pearl Echo  Administration Console .  To configure SQL Server:  

1.  Copy the Pearl Echo  database (echodb00000) f iles located in the Utilities 

directory of the product CD  or installation folder  to your SQL Server.  

2.  Create a SQL Server  Authenticated  user called echouser with password 

echopassword.   

3.  Attach to the Pearl Echo  database by right clicking on Databases and 

selecting All Tasks ->Attach Database in the SQL Server Console . 

a.  SQL Server 2000:  While  attaching to the database, specify 

echouser as the database owner.  

b.  SQL Server 2005  and later :  After  attaching to the datab ase, 

select  Security -> Users  for the echodb00 000 database, add the 

username "echouser" with login name "echouser", and assign the 

role  db_owner.  

4.  Create a network share on the SQL Server named cache0000000000 and 

apply read and write permissions to the domain computer on which the 

Pearl Echo  Server Softwa re  resides  (verify the Share has read and write 

access under both the Share Permissions and NTFS Security tabs) .  This 
share will be the location where Echo will store additional cached content . 

To configure the Pearl Echo  Administration Machine  to store m onitored 

Internet activity to the Echo database on Microsoft SQL Server, enter the 

Pearl Echo  Administration Console and select Data Source Selection from the 

Options menu.  S pecify the name of the Microsoft SQL server and the 

database (echodb00000) and ta ble (echotab00000) where Pearl Echo  should 
log activity.  

NOTE: The above configuration requires that you h ave a licensed version of 

Microsoft SQL Server  and the Pearl Echo SQL Server Module . 

NOTE: Alternative SQL database products (e.g.  SQL Server Express )  may 

operate when substituted for a fully licensed version of Microsoft SQL Server, 

however Pearl Software is unable to support configurations other than its 
native Microsoft xBase or a fully licensed version of Microsoft SQL Server .  

 

R Verify the 

Authentication 
Mode of the SQL 
server is "Mixed 
Mode ( Windows 
Authentication 
and SQL Server 
Authentication)".  
 
Authentication 
Mode is found i n 
SQL Server 
Management 
Studio : R ight -
click your server, 
and then click 
Properties  and 
Security . 
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SQL Server Data Main tenance (Optional Sample)  

Pearl Echo includes sample files  to backup aged data* stored on your SQL 

Server primary Pearl Echo database to a backup database.  To backup data 
stored from your primary Pearl Echo database, echodb00000:  

Attach the Supplied Pearl  Echo Backup Database  

1.  Copy the Pearl Echo backup database (echodbBackUp) files located in the 

Utilities directory of the product CD or installation folder to your SQL 

Server.  

2.  Attach to the Pearl Echo backup database by right clicking on Databases 

and selec ting All Tasks ->Attach Database in the SQL Server Console.  

a.  SQL Server 2000:  While attaching to the database, specify 

echouser as the database owner.  

b.  SQL Server 2005  and later :  After attaching to the database, 

select Security ->Users for the echodbBackUp dat abase, add the 

username "echouser" with login name "echouser", and assign the  
role  db_owner.   

Schedule the Backup Job  

1.  Start the SQL Server Agent.  

2.  On the Jobs Folder, Right Click and select ñNew Jobò. 

3.  Enter EchoBackup  as the job "Name".  

4.  Select "Steps" in t he left hand window pane.  

5.  Click "New".  

6.  Enter EchoBackupStep  as the "Step name".  

7.  In the Command Window, type exec  echodb00000.dbo.job_backup  

8.  Click "OK".  

9.  Select Schedules in the left hand window pane.  

10.  Click "New".  

11.  Enter EchoBackupSchedule  as the "Name".  

12.  Configure the schedule parameters as you require and click "OK".  
13.  Click "OK" to finalize the new scheduled job.  

*The default value for aged data is 14 days.  You can change this by 

modifying the stored procedure, dbo.job_Backup, located in         
echodb00000 ->Programmability ->Stored Procedures.  

1.  Right click on dbo.job_Backup.  

2.  Select ñModifyò. 

3.  Modify the integer 14 in the line      

 SET @start_log_date = dateadd(day, -14 ,getdate())  
4.  Select ñExecuteò from the Query tool bar 
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SQL Server Index Maintenance *  (Optiona l Sample)  

Pearl Echo includes sample files  to  tune fragmented index files in your SQL 

Server primary Pearl Echo database  and your backup database.  In addition, 
scripts are included to add index  maintenance as scheduled jobs. 

1.  Start the SQL Server Agent.  

2.  SQL Server 2000 or  2005 : Locate the index maintenance files in the 

Utilities \ SQL Server Files \ Index Maintenance \ 2005  directory of the 

product CD or installation folder.  

SQL Server 2008 or later : Locate the index maintenance files in the 

Utilities \ SQL Server Files \ Index Maintenance \ 2008  directory of the 

product CD or installation folder.  

3.  To rebuild  the primary  Pearl Echo indexes:  

a.  Open the file 1 - job_RebuildIndexes.sql  

b.  Execute  the script  

4.  To rebuild  the backup  Pearl Echo indexes:  

a.  Open the file 2 - job_RebuildIndex es.sql  

b.  Execute the script  

5.  To create  the primary  Pearl Echo index job:  

a.  Open the file 3 - echodb00000_IndexMaintenance.sql  

b.  Execute the script  

6.  To create  the backup  Pearl Echo index job:  

a.  Open the file 4 - echodbbackup_IndexMaintenance.sql  
b.  Execute the script  

By def ault, the index maintenance jobs will be scheduled to run each morning 

at 1:00 AM.  

*Pearl Echo SQL Database Module 10.06.0006 or later must be attached prior 
to setting these index maintenance functions.  
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Feature Overview  

Pearl Echo  tracks Inte rnet activity by looking at content as it travels to and 

from a workstation computer via the computerôs built in networking 

components.  Pearl Echo adds s ecurity way -down - low to analyze network 

protocols so you have no worries about application choices, pl ug - in headaches 

or compatibility issues. This approach enables Pearl Echo  to run reliably and 

silently in the background. The only indication that Pearl Echo  is running is 

the display of an optional warning message or web page redirection on the 
Workstatio n that can be configured in the Pearl Echo  Administration Console . 

Pearl Echo ôs Administration Console  allows you to customize how you monitor 

and manage access to Internet Web, Email, Chat, Instant Messaging, News 

and FTP.  Controls can also be placed on non - Internet -specific applications 

like Word, Solitaire, iTunes etc. Access Control Profiles are used to set  the 

access privileges of individual users,  groups of users  or computers .  If you 

install Pearl Echo  Server Software on a machine in a Windows Domai n, User 

names, Group names  and Computer names  are gathered from your Active 

Directory database. This enables seamless  administration by eliminating the 

need to maintain separate login  accounts in the Pearl Echo  Administration 

Console . 

Monitoring Employee I nternet Access  

Pearl Echo  allows you to retrace nearly every step an Internet user makes, by 

creating a complete audit trail of Internet activity, including site visits , file 

t ransfers, news  group activity , chat, instant m essaging, and email. Pearl 

Echoôs Quick LinkÊ feature allows the password holder to automatically link 

back to the actual Web and FTP sites the user visited, or to restore the 

content  of incoming and outgoing postings , Email, Chat and Instant 

Messaging items. As a monitoring tool, Pearl Ec ho  watches Internet activity 
and reports it back to you.  

Managing Employee Internet Access  

For managing Internet access, Pearl Echo  provides fully customizable Allow 

and Block Control lists that are categorized into Web sites, FTP resources, 

Email addresse s, newsgroups and chat/instant messaging. Internet Security 

control can be set to allow varying levels of access. Each segment of the 

Chapter  
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Internet can be set independently with the default being set to allow and 

monitor all sites.  Within the Pearl Echo  Admini stration Console you can 

create Internet access Profiles in order to set varying levels of restrictions 
based on existing Windows User , Group  and Computer  definitions . 

Pearl Echo  can also be configured to block incoming and outgoing content 

based on a n adm inistrator -defined set of keywords  and text patterns . The 

primary focus of this feature is to protect against the dissemination of private 

information. This feature can also be used to block content that contains 
offensive material.  

Pearl Echo also support s bandwidth limits .  With Pearl Echo you can allocate a 

daily allotment of bandwidth to users, groups or computers.  Different levels 

of bandwidth can be assigned to different use rs and varied by Internet 

activit y. 

Pearl Echo  includes a set of categorized Echo.Filters Ê based on an 

automatically updating database of Internet  domains.  Using Echo.Filters , you 

can provide access to Web content based on content type.  There are over 4 0 

Echo.Filters  categories from which to choose include shopping, job search, 

adult, and social media sites,  to name a few.   

In addition to the above modes of control, Pearl Echo allows you to control 

the daily time usage of non - Internet -specific applications.  Specified programs 

can be completely blocked from running or allotted a specified number of 

minutes per day.  Application blocking can be combined with Pearl Echoôs 

powerful time controls to allow access to blocked applications during certain 
times of the day like lunch hours or after work hours.  

Pearl Echo ôs comprehensive approach to managing employee Internet access 

provides you with the ability to  completely  customize access modes as well as  

immediately override and update blocked material.  

Pearl Echo  Security  

Pearl Echo  Administration Machine  

Pearl Echo  logs Internet activ ity to files on your Pearl Echo  Administration 

Machine . Since Pearl Echo  runs as a network service, all Pearl Echo  files and 

configuration settings are well protected by your server's built in security. In 

order to function, t he Pearl Echo  Server Software  installation directory need 
not be accessible by users on your network.  

Pearl Echo  Workstation  

Pearl Echo  workstation files are protected by Pearl Echo ôs built in security.  

The workstation uninstall is password protected and file tampering will cause 

Int ernet access to be terminated  if Security Tampering is set to Medium or 

High during the Pearl Echo Workstation installation .  Additional security is 
provided via Windows ACL permissions.  
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Using Pearl Echo  

Signing In  

Each time you start the Pearl E cho  Administration Console , you will be 
prompted for your login password.  

 

After your password is confirmed, you will be presented with  the Pearl Echo 

Navigator providing you access to the most common Pearl Echo features and 

administrative tasks  including  running reports as well as viewing the Pearl 

Echo Activity Log .  While in the Pearl Echo Administration Console, you will 

have access to the most current copy  of the Pearl Echo  Activity Log. You can 

perform any file operation on your copy  of the log witho ut altering the 

integrity of the actual secure  Pearl Echo  log.   

The Pearl Echo  Administration Console supports an Administrative and User 

level log in.  The User Level password allows users other than the 

administrator to view the Pearl Echo  Activity Log a nd run Pearl Echo  reports.  

All Pearl Echo  features are available in the User Level except features that 

control Pearl Echo  security configurations.  The Administrative Level log in 
allows access to all Pearl Echo  features and settings.  

Chapter  
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Viewing the Activit y Log  

The Pearl Echo  Administration Console displays a copy of real - time monitored 

Internet activity in the Pearl Echo  Activity Log Window.   There are a number 

of ways to open and refresh the Pearl Echo Activity Log Window, the easiest 

being pressing the F 5 function key or clicking the leftmost toolbar button.  

 

The Pearl Echo  Activity Log presents Internet Activity by the following 
categories:  

Source:  The type of Internet activity being logged. This can be Web, Ftp, 

Email, News, Chat/Instant Messaging, or  Web -Mail. Web -Chat and Instant 

Messaging are  logged as Chat.  

Site:  The address of the Internet activity being logged. This can be a Web or 

Ftp location. It can also be an Email address, News Group name, Chat 
channel or Instant Messaging ID.  

Subject:  The subject or title of the activity being logged. For Email and News 

this will be the text that appears in the message subject line. For Web 

activity, the Web page title will appear here. For Chat and IM, the first line of 
the conversation will be displayed.  This entry will remain blank for Ftp.  

Date:  The date and time of the Internet activity being logged.  

Control:  Displays the Pearl Echo  Control that has restricted access to 

Internet content. Examples include Keywords, Ratings, Block List and Allow 
List s, T ime Limits and Bandwidth Limits . 

User:  The Microsoft Windows  login name of the user being monitored.  

Computer:  The Wi ndows computer name associated with the computer being 

monitored.  
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MacID:  The Media Access Controller ID (MacID) of the monitored 

workstati on.  The MacID is a unique ID associated with the network card 

within a workstation.  

Signatures:  Data verification is performed at the Pearl Echo  Workstation on 

all data sent to the Pearl Echo  Administration Machine .  Individual check -sums 

are performed o n the logged record data (Signature - r) as well as associated 
file attachments (Signature - f).  

Remote Administration  

Pearl Echo  configuration settings can be remotely administered with Remote 

Desktop, Terminal Services or any third party remote connection so ftware.  

Pearl Echo  uses a global protection mechanism to guard against access of the 
Pearl Echo  Administration Console  from simultaneous user sessions.  

Viewing Logged Email, News, Chat & IM  

Pearl Echo  monitor s and control s all Internet standard Email (Pop -

3/SMTP/IMAP/ GroupWise/ Web -Mail), NNTP Ne ws, and Chat/Instant 

Messaging in S kype for Business .  To view the content of incoming and 
outgoing Email, News, IM, and Chat:  

1.  Select the desired entry from the Pearl Echo  Log Window.  

2.  Click on the Text Button or Double click on th e desired entry.  

You will be presented with the monitored text. Encoded attachments will also 

be referenced. You can decode and read any email and News attachment by  

1.  Right click ing  on the desired entry from the Pearl Echo  Log Window.  
2.  Select ing  óDecode Attachmentsô from the shortcut menu.  

 

3.  Selecting the destination folder in which to store the attachments.  

The original decoded attachments will be available in the directory you 

specify.  You will need the fileôs associated application or viewer to open or 
run the attachments.  

R You can 

remotely access 
the Pearl Echo 
Administration 
Console throug h 
a built - in 
Terminal Server 
or Remote 
Desktop 
connection.  
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To capture the text of Email, Chat, IM, and News postings, select ñCache 

Textò from the Cache Control menu.  If you would like to log Email, News, 

Chat, and Instant Messaging activity without capturing content, select ñDo not 
cache Con tentò from the Cache Control menu.   

 

If you would like Echo to log a transaction's associated encoded attachments, 

select ñCache Text & Encoded Attachmentsò from the Cache Control menu in 

the Pearl Echo  Administration Console .  Pearl Echo includes a buil t in 

attachment decoder in order for you to view captured documents, spread 

sheets, images, etc.  

Quick -LinkÊ to Logged Sites  

You can use Pearl Echo ôs Quick Link feature to easily view the Web and FTP 
sites listed in your Pearl Echo  Activity Log.  

1.  To browse all sites, click the  Web  button on the active Pearl Echo  Log 

Window. This will automatically start your default web browser with links 

generated from your Pearl Echo  Activity Log.  

2.  To browse an individual site, double -click your mouse button on the log 

entr y that you want to visit. You can also choose ñGo to URLò from the 

popup  shortcut menu. Your default web browser will automatically start 

and access the site of interest.  

3.  You can also generate a permanent copy of your web page by selecting 

the ñPublish Browser Pageéò item from the File Menu. This is useful if you 

would like to create an HTML version of your Pearl Echo  Window in order 

to provide a starting point for Internet users.  Use this when you've 
logged your own research and would like to share the si tes with a group.  
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Searching the Activity Log  

The Pearl Echo  Administration Console  provides the ability to quickly search  

through the entries displayed in the active Pearl Echo  Log Window.   

In order to identify specific information, searching  can be done by keyword, 
date, user, computer, MacID, violations or Internet content type.  

The Keyword command in the Sort  menu allows you to enter a word or 

phrase by which to search  the contents of the active Pearl Echo  Log Window 

and associated text attachments. You  can include the words in the current 

Profile 's Words & Phrases List during a keyword search  by selecting ñSearch 
with items in Words & Phrases Listò in the keyword search screen. 

 

Items in the Pearl Echo  Log Window and any associated attachments that 

con tain instances of the words or phrases in the S earch  box or Words & 
Phrases List will be identified.  

Clearing the Activity Log  

The Pearl Echo  secure log file contains the list of activity logged during all 

managed Internet sessions. The ñClear Activity Logò command in the Security 

menu is used to clear the contents of the secure Pearl Echo  log file.   

Data that you view in the Activity Log Window is a copy  of the secure log.  

Modifying or deleting entries in any Activity Log Window has no effect on the 
act ual secure log file.   

R You can 

automatically 
archive or purge 
aged data to 
maintain the 
current Pearl 
Echo Activity Log.   
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Setting Pearl Echo  
Security Levels  

Turning Pearl Echo  Management On and Off  

You can turn the Pearl Echo  Internet Management service On and Off in the 

ñSet Security Statusò command of the Security menu. 

 

When the Pearl Echo  Management Service is On, Pearl Echo  is controlling 

Internet activity even after you exit the Pearl Echo  Administration Console 
and log off of the Pearl Echo  Administration Machine . 

It is recommended that you not  start and stop the Pearl Echo  Service from  

your systemôs Services Console. 

Chapter  

5 
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Administering Pearl Echo  Profiles  

A Pearl Echo  Profile is a group of settings you define to govern the Internet 

access permissions of your users.  Initially, the Default Profile governs all 

users.  Specific a ccess privileg es can be  applied to individual users, groups of 

users  or computers .  Pearl Echo  Profile names are base d on your existing 

Windows User, Group  and Computer  names.  You can Add, Remove and 

Select the Current Profile in the ñProfile Settingsò command of the Security 
menu.  

 

The Pearl Echo  Administration Console will access and display the available 

User , Group and Computer names from the Active Directory database w hen  

the  Pearl Echo  Server Software is installed on a machine that is part of a 

Domain usi ng the  Active Directory Service.  If Active Directory Service is not 

available, the Pearl Echo  Administration Console will access and display the 

available User and Group names from the server on which it is installed.  If 

you have not installed the Pearl Echo  Server Software  on a Windows server, 

the Pearl Echo  Administration Console provides you with the ability to  

manually create the User  and Computer  names for  Profiles that you would like 
to define . 

When a managed User attempts to access the Internet, their ac tivity is 

governed by one of your  Profileôs configuration settings. Pearl Echo  first looks 
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for a matching User Profile. If no matching User Profile is found, Pearl Echo  

looks for a Group Profile to which the User belongs. If no matching Group 

Profiles are found, Pearl Echo looks for a Computer Profile based on the 

computer name being used. If no matching Computer  Profiles are found, Pearl 
Echo  uses the settings defined by your Pearl Echo  Default Profile.  

 

(Note: If a User belong s to multiple groups, Pearl Echo selects the first 
matching Group (alphabetically) to govern Internet access.)  

For more information on this subject or to practice using this feature, please 

see the  Pearl Echo  Tutorial  in the programôs Help menu. 

 

User  Profile  

 

 
Group  Profile  

 

 
Computer  Profile  

 

 
Default  Profile  
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Settin g Pearl Echo  Control Levels  

Access control is configured in the Profile's Custom Controls tab. Access  levels 

are established by selecting the appropriate button under each control  

category in conjunction with entries in the Profile's Allow and Block Contro l 

Lists.  

 

Off:  Select Off to give the selected  Profile full Internet access with no 
monitoring.  

Allow All:  Select Allow All to give the selected Profile full Internet access with 

monitoring. Unlike the Off level, all Internet activity will be logged. In this 
example, full E-mail  access is granted and E-mail content  is logged.  

Allow Listed:  Select Allow Listed to have Pearl Echo  block all Internet 

activity except for a list of permissible sites defined in the selected Profile's 

Allow Control lists. All Int ernet activity will be logged. In this example, Web  

access is granted to only the addresses listed in the  selected  Profile's Web  
Allow List.  
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Block All:  Select Block All to have Pearl Echo  block the selected  Profile's 

Internet activity. All activity is logg ed. In this example, all file uploads and 

downloads using FTP and Web browser programs  will be blocked.  

Block Listed:  Select Block Listed to have Pearl Echo  allow all Internet activity 

except for a list of objectionable sites defined in the selected Profil e's Block 

Control lists. All Internet activity will be logged. In this example, Chat/IM 

access is blocked to only the chat groups  and contacts  listed in the selected 

Profile's Chat Block List.   This example also shows that Applications listed in 

the select ed Profile's Application Block List will be blocked after a configurable 
amount of daily usage.  

Auditing Words & Phrases  

You can have Pearl Echo  identify when specific content is transmitted in any 

segment of the Internet by selecting ñAudit content containing restricted 

Words & Phrases.ò  With this option set, Pearl Echo  will allow all Internet 

activity to proceed but will highligh t transactions containing words, phrases or 

text patterns defined in the  selected  Profile's Words & Phrases Control list. 
The W ords & P hrases List applies to all Internet content.  

Blocking Content Based on Words & Phrases  

You can have Pearl Echo  block objectionable words, phrases  and text patterns  

in all segments of the Internet by selecting ñBlock content containing 

restricted Wo rds & Phrases.ò With this option set, Pearl Echo  will allow all 

Internet activity exce pt for content containing words, phrases or text patterns 

defined in the selected Profile's Words & Phrases Control list. The Words  & 

Phrases List applies to all Internet  content.  

When content is blocked based on a keyword or phrase, the user will not 

receive or transmit the blocked content but the content will be available for 

the administrator to review from within the Pearl Echo  Administration 
Console , including the tex t of Email, News and Chat/IM . 

For more information on this subject or to practice using this feature, please 

see the  Pearl Echo  Tutorial  in the programôs Help menu.  

Encoded Attachments  

The audit and block keyword features can also be applied to encoded 

attachments in Email and News group postings.  By selecting ñExtend 

keyword check to include encoded attachments,ò Pearl Echo  will decode 

attachments in real - time and search the attachment for textual data that 

matches words, phrases or text patterns defin ed in the selected Profile's 
Words & Phrases Control list.  
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Secure Web Site  Control 2  

Pearl Echo provides full visibility into encrypted data while it resides on  the 

managed workstation (Note: Encrypted data remains encrypted as it travels 

to and from the m anaged workstation ). The c ustom access rules that you 

assign to  the current Profile are automatically applied to encrypted 

communications.  If your organization  dictates that you not manag e 

encrypted data, you can have Pearl Echo ignore this content by sel ecting 

ñDonôt manage secure content (https, ssl, etc.).ò   

Safe Search  

You can restrict the current Profileôs web searches to use a search engineôs 

ñsafe searchò setting.  Safe  search is a search engine feature t hat acts as an 

automated filter to potential ly offensive content.  This setting is controlled by 

the user but can be overridden by Pearl Echo. Pearl Echo enforces the safe 

search feature of the following major search engines: Google, Bing and 
Yahoo.  

Global Warning Message  

You can prevent  Pearl Echo from displaying your custom warning message for 

a specific Profile.   This can be used if you have configured Pearl Echo to 

display  a warning message  to users  or redirect a blocked web page  but want 

to run Pearl Echo in si lent mode for a particular user, group of users  or 
computer .  

Blocking Applications  

You can block access to any application a user may run.  This is accomplished 

by setting Apps to Block Listed in the current Profileôs Custom Controls tab. 

The applications blocked are listed in the  current  Profileôs Applications Block 

Control List.  Applications can be set to be blocked immediately or after a 

period of daily usage.  Users will be warned five minutes before an application 
is terminated due to expiration of an  allocated allotment of time.   

Applications are considered active when they consume CPU cycles.  For 

example, Notepad, while minimized, is inactive -  it uses no CPU cycles. If 

notepad.exe is in a userôs Applications Block Control List, the user does not 

get charged for Notepad being open and minimized. iTunes, while minimized, 

is active -  it uses CPU cycles. If itunes.exe is in a userôs Applications Block 
Control List, the user does get charged for iTunes being open and minimized.   

Application restrictions can be overridden with the Profi leôs Time Control 

settings.  In addition, t he default warning message can be suppressed  by 

selecting, ñDonôt use global warning display settingsò in the Profileôs Custom 
Controls tab.  

 
2
 Applies to  Windows 7 and later.  
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Assigning Pearl Echo  Control Lists  

You can assign the Control Lists tha t a Profile uses in the Custom Lists tab of 

the Profile window.  A Profile can share Control Lists with other Profiles in 

order to reduce administration.  A Profile can also have its own set of custom 

Control Lists if you need to define specific access lis ts for specific Profiles .  

When a new Profile is created, it automatically shares the Default Profile ôs 
Control Lists.   

 

To create a separate set of Control Lists for a Profile:  

1.  Select the New Control Lists b utton in the Custom Lists tab of the 

Profile W indow.  

2.  Assign a name to the new set of Control Lists.  
3.  Select  OK.  

The selected Profile will have a new set of blank Control Lists into which you 
can add  or import entries . 



P E A R L  E C H O  U S E R ô S  G UI D E  

42  

 

To share an existing set of Control Lists with  the selected  Profile:  

1.  From the Profil e tab, select the desired Profile in the Current Profile 

box.  

2.  Select the existing Control List name in the Custom Lists tab for the 

selected  Profile.  
3.  Select  the Add Profile button . 

The list of Profiles that share the selected  Control Lists appear in the ad jacent 
display.  

Using Pearl Echo  Allow and Block Control Lists  

Pearl Echo ôs customizable  Allow Lists are used to block all Internet activity 

except for a list of permissible Web Sites, Ftp Sites, Email contacts, News 

groups and Chat/IM groups. This is usef ul when a Profile's access needs to be 

limited  to a defined list of web sites or Internet addresses . 

Pearl Echo ôs customizable Block Lists are used to allow all Internet activity 

except for a list of unacceptable Web Sites, Ftp Sites, Email contacts, News 

groups and Chat/IM groups.  Pearl Echo also allows you to block access to 

applications after they have been used for a specified period of time.   

There are a number of ways to edit the selected  Profileôs Control Lists. 

Manual Edit  

To manually edit a Profil e's Control List, select the desired list from the 

Security menu.  

  

With in  the selected Profile's Control List, you can add, remove and change 

entries. The format of the Control List entries must conform to Pearl Echo ôs 
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standard Control List syntax. For more information on Control List formats  or 

to practice using this feature, please see the  Pearl Echo  Tutorial  in the 

programôs Help menu. 

Automatic Add  

You can automatically add an individual  log entry to the current Profile's 

Control Lists from the sho rtcut menu.  

 

1.  Right -Click your mouse button on the log entry that you want to add to 

the current  Profile's Control List.  
2.  Select ñAdd to Block/Allow Listò. 

The selected entry will automatically be sent to the current Profile's Block or 

Allow  List .
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Automatic  Send  

You can automatically send all entries from a sorted or unsorted  activity  log 

window to the current Profile's control list by selecting "Send Log to" from the 
file menu.  

 

The appropriate entries will automatically be sent to the selected Block or 
Allow list.  
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Import Text  

You can import properly formatted text files into the Pearl Echo  

Administration Console  by selecting ñImport Textò from the File menu. Use 
this feature when copying  control lists or restoring lists from backup.  

 

Formatting Control List Entries  

Entries in Pearl Echoôs Block and  Allow Lists must contain valid address to 
insure proper functioning of the Control Lists.   

The following demonstrates the format of entries in the site column of Pearl 

Echoôs Control Lists: 

Web Address:   Hype rtext Transfer Protocol (HTTP)  

Example:   http://www.abc.com/news  

Secure Web:   Secure Hypertext Transfer Protocol (HTTPS)  
Example:   https:// www.facebook.com   

Ftp Address:   File Transfer Protocol (FTP)  
Example:   ftp://ftp.microcenter.com  

E-mail Address:  Mail  Transport Protocols (SMTP/POP -3/IMAP/GroupWise)  
Example:   rsmith@usda.gov  

News Group:   Network News Transfer Protocol (NNTP)  

Example:   alt.binaries.pictures  
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Skype  Chat:   Skype for Business /Skype for Office 365 Protocol  
Example:   skypeUserName  

The ñ*ò Wildcard 

The ñ*ò Wildcard can be used in your Web, FTP and Email Allow and Block 
lists to simplify administration.   

You can use one wild card per URL and it must:  

1.  Be the leftmost character in the URL  

2.  Completely occupy a base grouping in the URL  

The following examples illustrate how and when you might use the ñ*ò 
wildcard:  

To restrict a Profileôs email to inter-company email, add *@yourcompany.com 

to the Profileôs Email Allow List.  Set the Profileôs Custom Email Control to 
Allow Listed.  

To block th e receipt or sending of Yahoo! mail , add *@ yahoo .com to the 

Profileôs Email Block List.  Set the Profileôs Custom Email Control to Block 
Listed.  

To allow access to all intranet servers in your company  add 

http://*.yourcompany.com to the Profileôs Web Allow List.  Set the Profileôs 
Custom Web Control to Allow Listed.  

To block access to all Yahoo! content including mail and chat, add 

http://*.yahoo.com to the Profileôs Web Block List.  Set the Profileôs Custom 
Web Control to Block Listed.  

Proper  use of the ñ*ò wild card: 

Example:  http://*.abc.com/  

Effect:  Manages access to all servers at the domain abc.com (e.g. 
www.abc.com, www.machine1.abc.com, mail.abc.com, etc.)  

Exampl e:  http://*.au  

Effect:   Manages access to all domains with an au (Australia) suffix.  

I mproper  use of the * wild card:  

Example :  http://www.*.abc.com/  

Reason:  Wild card is not the leftmost character in the URL . 

Example :  http://www.a*c.com.com/  

http://*.abc.com/
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Reason:  Wild card does not occupy a base grouping in the URL  

The ñ*ò wild card can also be used as any octet in an IP address (e.g. 
http://212.148.*.*).  
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Blocking Web Content Using Echo .Filters  

You can block access to Web sites based on ca tegories of content in the 

Echo.Filters  tab of the Profile window. This feature is an optional module 
available with Pearl Echo .   

To block Web content based on categories, select the category to be blocked 

from the ñAvailable Categoriesò list on the left  and select the right arrow 

button to move it to the ñSelected Categories to Blockò list on the right . You 

can press the shift or ctrl keys to select multiple categories at once.  To add 
or remove all categories, select the right or left double arrow button.   

 

To block Web Content th at is not found in one of the existing Echo.Filters 

categories, add the ñOtherò category to the ñSelected Categories to Blockò 

list.   To block Web Content that is not yet categorized by Echo.Filters, add the 

ñIn Queueò category to the ñSelected Categories to Blockò list.  Uncategorized 

web sites are anonymously  added to the Echo.Filters update database for 

future review.  
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When a URL is blocked due to a category selection, the control in the Pearl 

Echo Activity Log will display, ñEcho Filtersò.  You can right-click on an entry 

in the Pearl Echo Activity Log to display the category which caused the web 
site to be blocked.   

Echo.F ilters  Updates  

Pearl Echo  will automatically update the Echo. Filters  datab ase throughout the  

day.  Sites that have not yet been categ orized are automatically and 

anonymously submitted to our categorization queue for human review.  The 

list of Echo. Filter s categories can be found in Appendix B of this Userôs Guide. 

When you enter the Pearl Echo  Administration Console , you will be notifie d 

when you are within two weeks of the expiration of your Category Updates.  

You may also receive an email notification from Pearl Software.  If your 

Category Updates expire, Echo.Filters  category lookups will  cease to function 

which may affect  access priv ileges  if so defined  as well as any reports that 
contain  category information . 

Setting Bandwidth Restrictions  

You can use Pearl Echo to allocate a daily allowance  of bandwidth for a Profile.  

Bandwidth is specified in Megabytes (1 million bytes).  Separate  allocations 
can be set for each of Web, F tp , E-mail, News and Chat/IM.  
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In the above example, the Default  Profile is set to have  

-  1 Gigabyte (1000 Megabytes) of daily Web activity  

-  750 Megabytes of daily Ftp activity  

-  500 Megabytes of daily E -mail activity  

-  250 Megabytes of daily News activity  
-  100 Megabytes of daily Chat/IM  

Users will be warned when they are within five percent of their daily 

allotment. Bandwidth restrictions can be overridden with the Profileôs Time 

Control and Allow List settings.  In addi tion, the default warning message can 

be suppressed by selecting, ñDonôt use global warning display settingsò in the 
Profileôs Custom Controls tab.   

If a bandwidth limit is reached in the middle of a communication, the 
communication will complete before t he bandwidth restriction goes into effect.  
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Setting Time Restrictions  

You can use Pearl Echo  to restrict the days and hours during which a Profile 

can access the Internet. You can also provide  free access with or without 

monitoring during specified time pe riods.  The default configuration is to allow 

a user to connect  and be monitored  during all hours of all days of the week.   

 

In the above example, the Default  Profile is set to have  

-  No Internet access after -hours  from 8 p.m. to 6 a.m. (red)  

-  Uncontrolled  access without monitoring on weekends (white)  

-  Uncontrolled access with monitoring during the lunch hour (green)  
-  Controlled access during all other time periods (blue)  
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To manage log in hours:  

1.  Select the hours to be administered:  

¶ To select one hour, click that hour.   

¶ To select a block of time, click the beginning hour and drag 

through the rows and columns to the ending hour.  

¶ To select an entire day, click that day in the left column.   

¶ To select one hour for all seven days, click the top of that column.   

¶ To select the entire week, click the upper - left box (above Sunday).     

2.  Select the type of access:  

¶ To allow controlled access during the selected hours, click 

ñControlled Accessò.  

¶ To deny connections during the selected hours, click ñNo Accessò.   

¶ To all ow monitored connections without any controls you have set, 

click ñFree Access (monitored)ò.  

¶ To allow unmonitored connections without any controls you have 

set, click ñFree Access (unmonitored)ò.   
3.  Repeat steps 1 and 2, as necessary.  

Suggestion : When usin g time controls, you may  want to restrict users from 

altering their workstationôs clock.   This is accomplished with Windows Group 

Policy.  

Pearl Echo Time Controls take precedence over  all other forms of access 
controls . 

Using Keyword Blocking and Auditing  

You can configure Pearl Echo  to block or audit a Profile's inbound and 

ou tbound content containing words, phrases  and text patterns  that you 

specify. The primary focus of this feature is to protect against the 

inappropriate dissemination of confidential i nformation. This feature can also 

be used to block or warn of material that contains offensive content .  

There are two methods to block or audit content based on words and 
phrases:  

Default Method  

Content that contains your specified words by themselves or a s part of 

another word will be blocked or audited. For example, if your Block List 

contains the entry ópainô, content that contains the word ópainô or óSpainô will 

be blocked or audited. This is the default method.  

Exact Method  

Content that contains your s pecified words by themselves will be blocked or 

audited. For example, if a Profile's Block List contains the entry ó!pain!ô, 

content that contains the word ópainô will be blocked or audited. Content that 

contains the word óSpainô will not be affected. You must place exclamation 

points (!) around the words you want to block or audit with the exact method. 
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This allows you to use the Default and Exact methods simultaneously  for 
different words and phrases . 

Pearl Echo can also be configured to block or audit co ntent based on  

character  patterns that you specify.  You can use the pound character (#) to 

represent digits and the question mark character (?) to represent letters.  For 

example, to block or audit any inbound and outbound transmission of social 

security numbers, you could use the following pattern in your Keyword 

Control List: ### -## -####.  Patterns can be specified in the Default or 
Exact Method as described above.  

Entries in your Allow Control Lists will override  other controls including entries 

in your Words & Phrases list. This is useful for allowing access to sites, 

emails, etc. that may occasionally present ñiffyò material but do so in a 

manner that does not violate your Acceptable Use Policy.  

Note: Time Controls will take precedence over all other c ontrols including 
Allow List entries.  

For more information on this subject or to practice using this feature, please 

see the  Pearl Echo  Tutorial  in the programôs Help menu. 
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Combining Security Features  

 

A profile's Custom Controls, Echo. Filters, Bandwid th and Time Controls can all 

be used simultaneously and in concert with one another.  For example, if a 

site is not contained in an Echo. Filters category, you can block the site by 

adding it to the Profileôs Web Block Control list and setting the Custom 
Controls level to ñBlock Listed.ò  

Similarly, you can add keyword controls for a profile to block content not 

specified in your Block Control Lists and not contained in the Echo .Filters 
database.  

Entries in your Allow Control Lists will override blocks of co ntent 

specified in all other controls with the exception of time controls.   This 

is useful for allowing access to sites, e -mails, etc. that may occasionally 

present ñiffyò material but do so in a manner that does not violate your 

Acceptable Use Policy.  Th is is also useful to immediately unblock a site that 

you feel does not belong in an Echo. Filters category.  Entries in your Allow 

Control Lists are in effect, even if Custom Controls are not explicitly set to 
ñAllow Listed. ò 

Time Controls work across all s egments of the Internet and take precedence 

over all other forms of Pearl Echo Controls.   For example , you can block 

specified applications like games and file sharing programs but override the 

block during lunch.  Similarly, you can override Bandwidth blo cks after normal 
working hours.  

The following questions are frequently asked about combining security 
features:  

Q.  Do I need to set Web cont rols to óBlock Listedô for Echo.Filters to work?  

A. No. Any filter category selected to be block ed will do so regard less of your 

Custom Control settings.  The Echo. Filters module must be purchased and 

must not be  expired in order to control and report web activity by content 

category.   

 

Q.  How do I allow access to only specific sites?  

A. The quickest way to accomplish this is to monitor yourself browsing to the 

allowable sites.  You will see the sites you accessed in the Pearl Echo 

Activity Log.  Add the allowed sites to the Profiles Web Allow List.  Do this 

by right clicking on the logged entries and selecting óAdd to Allow List. ô  

Alternatively you can use the óAutomatic Sendô feature combined with 

Pearl Echoôs search capability to quickly add all logged sites to a Profileôs 

Web Allow List. Once added to the Web Allow List, y ou should edit the list 

to use wild cards.  For instance, sites like yahoo.com have multiple hosts 

that provide content : www.yahoo.com, finance .yahoo.com, 
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f11.yahoo.com, etc.  You can quickly  cover this scenario by using the ó*ô 

wildcard, like http://*.yahoo.com .   

 

Q.  Why do my new Profiles have en tries in their Block and Allow Control 

Lists ? 

A. By design, new profiles inherent the Default Profileôs control settings and 

share  the  Default Profileôs Block and Allow Control lists.  Once the new 

Profile is created, you can easily create a unique set of Allow and Block 

lists for the new profile.  Do this by selecting óNew Control Listsô in the 

Custom Lists tab.  The new Control Lists that you create can be specific to 

a single Profile or be shared amongst multiple profiles.  
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Additional Pearl  Echo  
Features & Settings  

Refreshing the Pearl Echo Activity Log  

Pearl Echo captures Internet activity in real - time.  The Pearl Echo  Activity Log 

shows  a copy of the most current Internet activity up to the moment that you 

open the Pearl Echo  Activity Log . If Pearl Echo  Workstations access the 

Internet while the Pearl Echo  Administration Console  is open, you will need to 

refresh the Activity Log to view the latest Internet activity. To view updated 
Internet activity use the ñOpen Activity Logò command in the File menu.  

The Navigator, toolbar and  shortcut menus can also be used to open a new 

copy of  the Activity Log.   Each time you open the Activity Log, a new window 

is created which can eventually clutter the Administration Console.  Using the 
F5 key will refresh an open Activity Log . 

To automatically update the Pearl Echo  Activity Log, select ñAuto-Refreshò 

from the File menu.  While in Auto -Refresh mode other Pearl Echo  

Administration Console  features are unavailable.  Press Alt+F5 to escape 
Auto -Refresh mode.  

Excluding Data from  Being Saved in the Activity Log  

Pearl Echo  can be configured to exclude a list of Internet addresses from 

being logged.  This is useful if frequented URLôs or other addresses are not of 

particular interest or may be skewing the re sults of reports or other analysis.  

Examples include Web activity that pulls advertisements from advertising 

sites, web access to an organizationôs intranet sites , or communications that 

may be considered privileg ed or protected as confidential such as 
wh istleblower or employee ethics hotlines.  

To add Internet addresses that should not be saved in the Pearl Echo  Activity 
Log, select ñExclude Sites from Logò in the Pearl Echo  Options menu.   

 

 

Chapter  

6 

R Pressing the 

F5 key wi ll 
refresh an open 
Pearl Echo  
Activity log.  
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Web addresses must contain the http:// or https:// prefix and are applicable 

to the entire specified domain.  Addresses from any source of Internet activity 

(web, ftp, email, news, chat, im) can be added to the list of excluded sites. 

Although the specified activity will not be saved in the Pearl Echo  Activity Log, 

the listed Internet addresses may still be controlled based on restrictions you 
may have defined in your Pearl Echo  control Profiles.  

You can also use the ñ*ò wildcard in the Excluded Sites list.  For example, 

adding the entry http://*.js will exclude all sites from being logged that 

contain a java script suffix.  The entry *@mycompany.com can be used to 
exclude all internal company emails from being logged.    

When using the Echo .Filters subscription, Pearl Echo will log Web activity 

based on content categor y.  Internet addresses can also be excluded from 
being logged based on these categorized transactions.  
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Web activity may occur even when a computer is idle; web pages may refresh 

or applications  like antivirus programs  may automatically ñphone homeò.  You 

can suppress the logging of web activity that occurs when a machine is idle by 
selecting ñExclude all web site entries when computer is idle for n minutes.ò 

The Pearl Echo  Activity Log Database  

Pearl Echo  stores data in an open xBase database format.  Yo u do not need to 

install a third party RDBMS when using Pearl Echo  with its native database.  

The Pearl Echo  native database size limit is 2GB.  For installations with high 

volume monitoring loads and large storage requirements, Pearl Echo  can 

easily be co nfigured to store monitored Internet activity to a Microsoft SQL 

Server.  

Configuring Pearl Echo to store data to Microsoft SQL Server will enable 

reporting over larger data sets and expanded time frames.  Report processing 

is done by the SQL Server engine  so it is extremely efficient.  Configuring 

Pearl Echo  to store data to Microsoft SQL Server provides additional flexibility 

to your organization: Pearl Echo  Administration Machine s can be placed at 

various locations to provide distributed Employee Interne t Monitoring and 

Control , yet all data can be centrally stored and managed for increased 
security, reliability and consolidated reporting.  

Integration with Microsoft SQL Server requires that you have both a licensed 

version of Microsoft SQL Server and the  Pearl Echo SQL Server Module.  Refer 

to the section ñIntegration with Microsoft SQL Server ò in Chapter 2 of this 
Userôs Guide for additional instructions on this topic. 

R Pearl Echo can 

be configured to 
log directly to 
SQL Server.  
 












































































